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ANENENEN

INTRODUCTION

SAP projects are used to define, document and implement company solutions to
given problems according to business requirements and SAP capabilities.

SAP provides many tools for creating projects, however, business requirements
come from businesses and are IT independent.

Business requirements are defined and formalized in modeling applications such as
MEGA Process.

SAP Solution Manager helps implement and manage complex system landscapes.
In general, systems are distributed across different geographic locations, and
business processes cover more than one system. With such complex scenarios, IT
success depends on the integration of technical and business requirements. SAP
Solution Manager provides SAP customers with an efficient means of handling both
the technical and business process sides of solution implementation.

In order to quickly implement their business strategies and orientations, companies
must be able to quickly transfer their processes and new business concepts to the
SAP world. It is therefore important to align the business requirements as seen in
SAP with what has been designed in HOPEX Business Process Analysis.

This is where HOPEX SAP Blueprint comes in. Its purpose is to design and
document how SAP meets the business requirements as defined in HOPEX
Business Process Analysis. It is used to exchange information relating to
processes between HOPEX Business Process Analysis and SAP Solution
Manager.

The HOPEX SAP Blueprint interface is used to align SAP process models with
business process models, thus providing organizations with the means for taking the
business view into account, improving implementation choices and reducing SAP
deployment and migration costs.

"Conventions Used", page 2

"Presentation of This Guide", page 3
"Presentation of HOPEX SAP Blueprint", page 4
"Presentation of SAP Solution Manager", page 6



CONVENTIONS USED

w  Remark on the preceding points.
Definition of terms used in this guide.
© a tip that may simplify things.

é& Things you must not do.

Very important remark to avoid errors during an operation.

Commands are presented in this way: File > Open.

The names of MEGA products and technical modules are presented in this way:
HOPEX.
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PRESENTATION OF THIS GUIDE

The following points are covered here:

"Exchanging Data with SAP", page 11: explains how to exchange objects between

HOPEX SAP Blueprint and SAP Solution Manager.

"Designing for SAP Projects", page 21: explains how to:

access SolMan data in HOPEX

manage SolMan objects

create mapping between SolMan objects and business objects

initialize a SolMan project from business objects

populate a BPMN diagram from a SolMan structure

exchange documents between HOPEX and SAP Solution Manager
e manage implementation, maintenance, and template projects

"Documentation in HOPEX SAP Blueprint", page 57: explains documentation

generation in HOPEX, including Web sites, reports and MS Word reports.

"HOPEX SAP Blueprint Glossary", page 77: definition of the main terms used in

this guide.

w The present document does not describe how to install the
components necessary for imports/exports into/from SAP Solution
Manager. Refer to the "MEGA SolMan installation guide" available with
the HOPEX SAP Blueprint portfolio.



PRESENTATION OF HOPEX SAP BLUEPRINT

With HOPEX SAP Blueprint you can:

e Manage SAP projects
HOPEX SAP Blueprint provides the metamodel structure necessary for
hosting SAP Solution Manager Blueprint artifacts and for connecting them
to the business view.
It manages the different lifecycle statuses of an SAP project. It
recognizes, when synchronizing an SAP project, if the project originates
from the evolution of the project lifecycle.

Maintenance
Project

e Exchange data with SAP Solution Manager
HOPEX SAP Blueprint provides tools for importing and exporting data
into/from SAP Solution Manager.

In order to exchange SAP Solution Manager project definitions with HOPEX, the
HOPEX SAP Blueprint interface relies on:
e A tool that exports/imports projects from/into SAP Solution Manager.
e A metamodel in HOPEX, called the SolMan metamodel that is used to
describe SolMan projects. This metamodel is linked to the MEGA
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Process metamodel in order to match Business modeling data with SAP
Solution Manager data.

(=_ ) [ p

Business Yiew in
MEGA

1

Designing ‘

l —

SAP View in SAP View in

MEGA Exchanging Data I Solution Manager




PRESENTATION OF SAP SOLUTION MANAGER

Concepts Used in SAP Solution Manager

SAP provides a wide range of enterprise software applications and business
solutions to empower all aspects of businesses. In its offering, SAP uses the concept
of process blueprints which are project-based process structures to help implement
and maintain its solutions such as ERP, CRM, SCM, etc. These blueprints are
maintained with the SAP Solution Manager tool.

SAP Solution Manager can be used to evaluate and implement solutions. This is done
through projects.

Each project has:

e a system landscape
A system landscape is composed of an arbitrary number of components
which are referenced by process steps and transactions.

e a Blueprint structure
Business Blueprints are used to document the business process
requirements of companies and give a general idea of how business
processes could be mapped in SAP Systems.

The Blueprint in Solution Manager is a hierarchical tree. At the top of the hierarchy
is the Project (where project is the name of the SAP Solution Manager project).
There are three levels to this hierarchy:

e Project level: Contains Master data, Organizational units, Business
Scenarios

e Scenario level: Contains Organizational units, Master data, Business
Processes

e Process level: Contains Process steps
Entities called transactions are commonly included in Process steps but
may also be attached to Processes and Scenarios.
This is the SAP view of business processes. This hierarchy is supported
and reproduced in HOPEX SAP Blueprint.



Presentation of SAP Solution Manager

Below is a diagram illustrating the SAP Solution Manager metamodel.

SolMan Project ]

SAP System
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SAP Solution Manager metamodel

The content of this structure is connected to the business view and maintained in

sync with its equivalent in SAP Solution Manager by the MEGA/SolMan Exchange
Module.

Overview of SAP Solution Manager

Let us take a quick look at how projects are presented in SAP Solution Manager.

1. Log on to SAP Solution Manager (Start > Programs > SAP Front End
> SAP Logon).

2. Select a server and click Logon.
3. Enter the user name > password and press the <Enter> key.

w ]f Solution Manager does not automatically start, run the "solar01"

transaction (below the menu bar, enter solar 01 in the field left of the
diskette and click the check button).

Introduction



By default, the last project used by the user opens.
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The project in this example is the Project SOLIMP1001 MEGA while the Project ID is

TMIDEVELO2.

The content of the project, such as the scenarios, business processes and processes
are presented in a tree hierarchy to the left of the window. The objects to be
exchanged with HOPEX are in this tree. When objects exist but are not displayed
in the tree, this is indicated by a clock with a green checkmark.

In exchanges, the same tree structure is displayed in HOPEX.
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When you click on an object in the tree, information relating to this object is
displayed in the corresponding tabs in the right frame.

Husiness Aluenrint Stouchure | iness Process Instore Producli
e e | _Stucture , cen.Documentation , Prol, Documentation , Administraion IENEXI
ll: gg :mnalmm Project Level [~ Fre———
= (1]~ Business Scenarios
>~ E iore Merchandise E
[¥] anizational Units .
0~ ::mr Data RG] | ] (i | E (Create MMS Mdse Catgry Hierar)
= [ Business Processes Transacti an TISAP ECC w621 @ | create merchandise categories

b Wore Price Management | |Transaction = SAP ECC = WEO1 & | create site

b 3[4 G Store Promotion Management | [Transaction ZsAP ECC 2 wBO2 @ | change site

b O @ Physical inventory Process| ||| |Transaction = S4P ECC [ MM41 @ | create article &

E g g :Isocr:':::nkmanagemem Level | [transaction msap Ecc T mMMaz | change Aricle &

b CI& G Transfers and Retums_planned | [Transaction FISAP ECC I MM43 [¥] | DisplayAdticle &

PO @ and Retums. _Tr‘ansac‘ti on ¥ SAP ECC 1 WSP4 [ (Create indiv. listing, art - site

b O @ VendorManagement | |Transaction TSAF ECC  EWwsL10 [ | Arices in Assortment

[P | @ Store Replenishment Transaction T SAP ECC [ CSOD1 [v] | Create Article BOM

r OO Store Assoriment Management " |transaction mSAP ECC T CE02 = | change Aricle BOM

= €1 @ instore Producti |rransaction msaF EcC [ cso3 ™ | DisplayAricle BOM
] Product cost planning Process " [Transaction mSaP ECC  ECKIIN @ | create article Cost Estimate
g :nce UPHAE e gron " |transaction T SaP ECC mCKIaN @ LDisplayAricle CostEstimate |

ricing
I

[ ] Sirmulation POS of Sales il R




Introduction




EXCHANGING DATA wWITH SAP

HOPEX SAP Blueprint enables to exchange SAP objects between HOPEX and SAP Solution
Manager.

In order to ensure consistency, the exchange is always performed on the basis of projects.

v "Import/Export Prerequisites", page 12
v "Importing/Exporting", page 14
v "Properties Exchanged between MEGA and SAP Solution Manager", page 17

w Before exchanging data, make sure the appropriate components
were installed. Refer to the "MEGA SolMan installation guide".

11
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IMPORT/EXPORT PREREQUISITES

Activating Variations

Before importing/exporting, it is advised to activate variations in HOPEX SAP
Blueprint.
w Variations are necessary to be able to view object versions and
differences.
(Windows Front-End) To activate variations:
1. Log in to HOPEX and from the HOPEX desktop, select Tools >
Options.
2. Inthe Business Process and Architecture Modeling group, select the
Activate variations option.

(Web Front-End) To activate variations:
1. Log in to HOPEX and from the HOPEX desktop, select Main Menu >
Settings > Options.
2. Inthe Business Process and Architecture Modeling group, select the
Activate variations option.

Import/Export Settings

To set the import/export settings:
1. Log in to HOPEX.
2. From the HOPEX desktop select:
e (Windows Front-End) Tools > SolMan Exchange.
e (Web Front-End) Main menu > SolMan Exchange.
3. In the wizard that appears, click Options.
A dialog box appears.

) SolManOptionsy3 @

Application Server:
Instance Number:
System ID:

Client:

Language:

[T Check Consistency
[T Check Mapping

You must complete the settings before the import/export can take place.

HOPEX SAP Blueprint



Exchanging Data with SAP ;
Import/Export Prerequisites .

Some of these settings directly correspond to the settings used for connection to
SAP Solution Manager with the SAP Front End:
e Application Server
e Instance Number
e System Id: number corresponding to the SAP system used
e Client: SAP client number
e Language: exchange file language

Other settings are available:

e Check Consistency: activates the consistency modeling rules for the
project being exchanged.

e If selected and an invalid consistency rule is encountered when the
exchange process is launched, this process is automatically aborted
and no exchange takes place.

e If left unselected: the exchange takes place if the data is correct. If
the data is incorrect, the exchange process fails.

e Check Mapping: activates the mapping modeling rules for the project
being exchanged.

e If selected and an invalid mapping rule is encountered, the exchange
process is aborted.

e If left unselected: the exchange takes place if the data is correct. If
the data is incorrect, the exchange process fails.

13
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IMPORTING/EXPORTING

Importing/Exporting a Whole Project

To import or export a project:

From the HOPEX desktop select:

e (Windows Front-End) Tools > SolMan Exchange.

e (Web Front-End) Main menu > SolMan Exchange.

In the window that appears, enter the Login and Password of the SAP
user with the appropriate authorization.

Click Next.

In the Select a project field, enter the Project ID of the project you
want to import from SAP Solution Manager or export from HOPEX.

This wizard helps you to import and export MEGA SolMan Project with SAP Solution
Manager,

Select a project: | MEGBPTIOL b

ar

Select the action to perform:
@ Import
) Export

w To obtain a project ID, see "Obtaining a Project ID in SAP Solution
Manager"”, page 18.

Select the exchange method considered:
e Import: selected by default.
The first time you use HOPEX SAP Blueprint, you must import a project
from SAP Solution Manager as you cannot create SAP projects in HOPEX.
e Export
m  The Project being exchanged must not be edited in SAP Solution
Manager during the exchange.
If you want to import/export some scenarios only, select the Partial
Import/Export check box.

w  For more details about this option, see "Importing/Exporting
Scenarios", page 15.

Click Next.
The project data import/export is being launched.

HOPEX SAP Blueprint



Exchanging Data with SAP
Importing/Exporting

8. Click Finish.

w [f the exchange does not start or you have an error message:

e verify your import/export settings. For more details on the
exchange settings, see "Import/Export Prerequisites”, page 12.
e view the trace file: from the HOPEX workspace, select ? > About

MEGA. Click the System Information button then Error Log >
Edit.

Importing/Exporting Scenarios

You can import or export only part of a project by selecting the scenarios which are
of interest to you.
To import or export scenarios:

1. See "Importing/Exporting a Whole Project", page 14.
2. In the import/export wizard, select the Partial Import/Export check
box.

m  To access the import/export wizard, see "Importing/Exporting a
Whole Project”, page 14

w  This check box is not selected by default.
3. Click Next.
4. From the list of scenarios listed, select "Yes" in the Import/Export
drop-down list.
w  For more details about the scenarios listed, see:

. "Importing scenarios", page 15
. "Exporting scenarios", page 16

" SolManV3 - MEGA SolMan ==

Select Scenario to Import/Expart:

Selected Scenario Mame Import/Export
iR Ves|

w  You must select at least one scenario here.
5. Click Next.
Depending on the action selected, the import or export is being launched.

Importing scenarios

When you choose to import a project partially, the list of scenarios listed is built from
the SAP server.
You can import a scenario:

e regardless of its presence or absence in the MEGA repository,

e even if the corresponding project still does not exist in the MEGA
repository.

15
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Only the objects located below the selected scenarios are updated.

Exporting scenarios
You can export scenarios which have never been exported before.

When you export a project partially, the SAPId of the objects located below the
selected scenarios are updated.

HOPEX SAP Blueprint
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PROPERTIES EXCHANGED BETWEEN MEGA AND SAP
SOLUTION MANAGER

The data exchanged between HOPEX and SAP Solution Manager through the
import/export tool is contained in the SolMan project.

SolMan projects are identified in HOPEX and SAP Solution Manager through their
SAP IDs.
As SAP IDs cannot be generated in HOPEX it is important that data imported

into HOPEX retain their SAP IDs so that when exported to SAP Solution Manager,
the objects with the same SAP ID in Solution Manager can be updated.

As such, objects imported into HOPEX:
e are assigned HOPEX IdAbs
e still retain their SAP IDs.

w The HOPEX IdAbs value is not directly available on the object as an
attribute in SAP Solution Manager.

SAP Ildentifiers

Objects created in SAP Solution Manager are automatically assigned SAP IDs.

When objects created in SAP Solution Manager are imported into HOPEX, the
values of these identifiers are kept.

w  SAP IDs cannot be generated in HOPEX so the SAP ID attributes
values for objects created in HOPEX remain empty.

Automatic specification of SAP IDs

To automatically specify SAP IDs:
) Export the SolMan project from HOPEX SAP Blueprint into SAP

Solution Manager.
IDs are automatically specified in SAP Solution Manager.

17



Obtaining a Project ID in SAP Solution Manager

To obtain a SAP project ID:
) In SAP Solution Manager, click the Other Project button or press
<Shift+ F5>.

A pop-up window appears with the list of projects. The current project is
highlighted. The project ID number is displayed in the Project column.

“Other Project” Icon

=
Sl
¥ i | S| JE Y = Y Systerr
Business Blueprint Structure | Froject
v &8 SOLIMP1001 MEGA s
P O Organizational Units ,_
|
|

1 i " Cumd
I@Elusiness Blueprint Change for Project TMIDEVELDZ2

B EEIELE

Froject |Type Title

TMIDEMOOO1 Implementation TMIDEMOOD1 MEGA International
TMIDEMOODOZ Implementation TMIDEMOOOZ MEGA International
Project ID | TMIDEMOOO3 Implementation TMIDEMOOO3 MEGA International
\ TMIDEMOOD4 Implementation TMIDEMOOD4 MEGA International

WIDEVELD1 Implementation TMIDEYORLYD1 MEGA International
¢ TMIDEVELD2 Implementation TMIDEYORLYDZ2 MEGA International
TMIDEVELD3 Implementation TMIDEYORLYD3 MEGA International
TMIDEVELD4 Implementation TMIDEYORLYD4 MEGA International
TMIDEVELDA Implementation TMIDEYORLYDS MEGA International
TMIDEVELOE Implementation TMIDEYORLYDE MEGA International

Accessing a Project ID in SAP Solution Manager

MEGA Identifiers

Objects created in HOPEX do not have SAP IDs.

HOPEX IDs are however assigned to objects created in HOPEX and those that
define projects imported from SAP Solution Manager.

Importing a SAP Solution Manager project into HOPEX

When you import a Solution Manager project into HOPEX:

e If no HOPEX identifier is specified, the object is created.
e If HOPEX identifiers are specified and the object already exists in
HOPEX, it is updated.
e If the object does not exist, it is created with the specified HOPEX
identifier.
w  When importing Solution Manager projects into MEGA, the MEGA

identifier of the newly created objects are automatically transfered to
SAP Solution Manager at the end of the import.

HOPEX SAP Blueprint
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Exporting a SolMan project from HOPEX

SolMan project objects exported from HOPEX have HOPEX IDs. When these IDs
are imported into SAP Solution Manager via the HOPEX connector, they are:
e kept and restored when the project is exported from SAP Solution
Manager
e re-imported into HOPEX.
w  When exporting SolMan projects from MEGA, the SAP identifier

associated to the created object in SAP is automatically transfered to
MEGA at the end of the export.

Names in HOPEX SAP Blueprint

Object names are managed through two different attributes:

e HOPEX Name
e SAP Name

Managing two attributes in HOPEX:

e Facilitates keeping SAP names and using different names in HOPEX

e Follows the rule of name uniqueness in HOPEX. If this rule is not
followed for objects coming from SAP Solution Manager, the names of
these objects are automatically modified in HOPEX.

When you change one of these attribute values, this does not affect the other.

» MEGA Name

SAP Name: | Store Merchandise nt *  SAP Name
SAF Id: DOCT7FET1BDSF6F1950D000C29684750
IV SolMan Scenario Is Active

SAP BPR Id: DOBESE41DAT49FERE 100000004 1 4ABS
SAP Area Name:

SAP Area Id:

SolMan Original Name: | Store Merchandise Management

SolMan Original Source: | Business Process Reposibory

SolMan Original Type: |1
Original Scenario: | 2]
P SolMan Scenario ;I

The SolMan Scenario is the highest level in the SolMan Project definition
struckure.

[k | caeel | i | hen |

&

When projects and their data are imported/exported into/from HOPEX, the SAP
name does not change.

19
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When exporting from HOPEX to SAP Solution Manager:
e If a SAP name is specified for an object in HOPEX, the SAP name
remains the same in SAP Solution Manager.
e If no SAP Name is specified for an object in HOPEX, the HOPEX name
(Local name) is taken into account in the export and becomes the name
of the object in SAP Solution Manager.

Namespace rules

When naming objects in HOPEX a particular namespace rule applies for the SolMan
metamodel.

According to this rule, no two objects of the same MetaClass can have the same
name.

If you try to give an object a name that is already assigned to an object of the same
MetaClass:

e the name is automatically modified.
e The string "-1" or "-[n]" is added to the name, where [n] is a number
that makes the name unique.

w  The value of n is incremented by 1 each time you try to the name.

Example

Two SolMan Processes exist in a SolMan Scenario and are
called "P" and "P-1". If you try to give a new SolMan
Process the name "P", the name "P-2" will automatically be
assigned to the new object.

This automatic behavior occurs when SolMan projects are
imported into HOPEX.

HOPEX SAP Blueprint



DESIGNING FOR SAP PROJECTS

SAP represents certain businesses in projects which are further subdivided into Business Scenarios,
Business Processes, Process Steps and Transactions. They also include Master Data and
Organizational units. All these objects are presented in a hierarchy in SAP Solution Manager.

HOPEX SAP Blueprint offers the possibility of presenting the SAP hierarchy in HOPEX to map
business processes modeled in HOPEX with the information in SAP. The hierarchy structure in SAP
Solution Manager is exported to HOPEX SAP Blueprint and seen identically in both products. You
then have the option of modifying the projects to better meet business requirements by adding or
deleting objects.

HOPEX SAP Blueprint enables you to align SAP Solution Manager project lifecycle with HOPEX
through management of implementation, maintenance and template projects.

HOPEX SAP Blueprint also enables you to initialize a SolMan project from business objects and
populate a diagram from a SolMan structure.

v/ "Accessing SolMan Data in HOPEX", page 22
v/ "Managing Projects", page 27
v "Aligning SAP Project Lifecycle with HOPEX", page 48

21
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ACCESSING SOLMAN DATA IN HOPEX

Once the SolMan projects have been imported into HOPEX, they can be viewed in

the Solution Manager navigation window.
Three types of projects can be viewed in HOPEX SAP Blueprint:

Implementation projects
An implementation project is used to implement business processes

in an SAP landscape.

e Maintenance projects
A maintenance project is used to maintain changes in the
productive environment (solution).

e Template projects
A template project is used to create and distribute a template

defining the project structure.
w  For more information about these project types, see "Overview of

SAP Solution Manager Lifecycle", page 48.
You can also launch an SAP transaction directly from HOPEX SAP Blueprint.

m  See "Viewing a Transaction”, page 25.

HOPEX SAP Blueprint
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Viewing SolMan Projects in HOPEX

Accessing SolMan projects

To view SolMan projects:
) In HOPEX Windows Front-End desktop select Navigation Windows
> Solution Manager.
} In HOPEX Web Front-End Enterprise Architect desktop, from the main
navigation menu select Solution Manager.
The "Solution Manager" navigation page appears.

== Solution Manager
¥ Z7 Solution Manager

= Hierarchy View

8 SAP Reference Models

B BPA - Solman Projects

B Solman Maintenance Projects
B Solman Templates Projects
PR All Business Processes
P All Functional Processes

= All Organizational Processes

- All System Processes

The Hierarchy View displays the repository in which you are working.

Contents of the Hierarchy View
All the projects created during imports can be found in a folder of the Solution
Manager navigation window. The folder depends on the type of projects imported.
Three types of projects are available:
e Implementation Projects
e Maintenance Projects
e Template Projects

w  Below is described the hierarchy of implementation projects. The
same hierarchy applies to maintenance projects and template projects.

23
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To access data from imports:

) Expand the folder corresponding to the type of project imported then the
project folder required to view the hierarchy.

= =) SOLIMPTONT MEGH
{0 Objects not present in SolMan
[#-4) Organizational Units
-4 Master Data
=11 Business Scenarios
ore
-0 Mapping
) Organizational Units
) Master Data
[=1 3 Business Processes

Project Level

Cl 1€ Flanagemen!

Scenario Level

[+ @ Store Price Management

Store Promotion Management

[ Physical Inventory

[ Receiving

[ Store Shrink Management

30 Transfers and Returns_planned

Transfers and Returns_unplanned

[ vendor Management

[ Store Replenishment

Store Assortment Management

@ Instore Production Process
£ Mapping Steps
@ Product cost planning

@ Price update /

@ Pricing

@ Simulation POS of Sales

@ Display Follow-on dacuments via POS moni
- @ Check of replenishment stock

& Replenishment planning

@ Retail Store _ Assumption of the purchase
@ Change a purchase requisition to a purchs
@ Retail Store_ Goods receipt with reference
@ Retail Store_ Physical Inventory

@ Retail Store_ Posting of perishables | disa|
#-(Z) Articles in Assortment

{2} Automatic Generation of POs

-3 Change Article &
&) Change Article BOM
{2} Change site
[-{Z) Create Article &

-
3]

M

&H-E-H

H-E-H-E

H-H

&)

o

+——— Transactions

0

[

Process Level

The hierarchy represented here reflects what is actually managed in the
corresponding view of SAP Solution Manager.

The objects managed are:
e SolMan Projects

SolMan Organizational Units
SolMan Master Data

SolMan Scenarios

SolMan Processes

SolMan Process Steps
SolMan Transactions

Manager except that transactions are displayed here.

The displayed hierarchy is almost the same as that displayed in SAP Solution

HOPEX SAP Blueprint



The icons corresponding to the different objects in an SAP Project are displayed in

the table below.

Designing for SAP Projects :
Accessing SolMan Data in HOPEX

Object type Icon

Owner object

Scenario

v

Project

Organizational Unit C::) Project , Scenario

Master Data - Project, Scenario
=

Process Scenario

Process Step Process

Transaction

ole|a

Process Step, Pro-
cess, Organizational
Unit, Master data

w  For more information about how to handle these objects, see

"Managing Projects"”, page 27.

Viewing a Transaction

You can view a transaction screen directly from HOPEX SAP Blueprint.
m  SAP GUI thick client must be installed on the workstation.

Defining settings

Before viewing a transaction, you need to define the settings required for

for transaction launch

authentication.

To define settings for transaction launch:

1.

2,

Access the SolMan project.

m  See "Viewing SolMan Projects in HOPEX", page 23.
Right-click the SolMan project and select Properties.

25
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3. Inthe SolMan Project Transaction Launch tab, specify the settings as
follows:
e Configured SAP Login: SAP client number
e SAP Language
e Server
e System Number
e System ID
e C(Client

m  These settings directly correspond to the settings used for
connection to SAP Solution Manager with the SAP Front End.

Launching a transaction

To launch a transaction:

) From a SolMan project properties, right-click a transaction and select
Launch SAP Transaction.
The transaction screen is displayed in HOPEX SAP Blueprint.

w  This feature is not available in HOPEX Web Front-End.

HOPEX SAP Blueprint



Designing for SAP Projects :
Managing Projects

MANAGING PROJECTS

The procedures and indications given below apply to:
e implementation projects
e maintenance projects
e template projects

w  For procedures specific to maintenance and template projects, see
"Aligning SAP Project Lifecycle with HOPEX", page 48.

About SolMan Projects

In SAP Solution Manager, components are used to:

e host transactions

e support processes
To ensure that processes and transactions are attached to components in a project,
the components used in the project must first be defined. The system Landscape of
the project defines these SAP logical components.
For this reason SolMan projects cannot be created in HOPEX. They must first be
created in SAP Solution Manager with their appropriate system landscapes and then
imported into HOPEX, even if no scenarios are selected in SAP Solution Manager.
After this first import, the project and its logical components are defined in HOPEX
with their correct SAP IDs.

Modifying SolMan Objects

Before modifying a SolMan object, you need to check whether it can be modified or
not. Some objects of the imported projects cannot be modified. You can identify
them thanks to the ® icon.

You first need to activate indicators showing the objects that cannot be modified.

Viewing objects that cannot be modified

To be able to view objects that cannot be modified:
1. From MEGA desktop, select:
e (HOPEX Windows Front-End) Tools > Options.
e (HOPEX Web Front-End) Main menu > Settings > Options.
2. In the left tree, select Status Indicators.
3. Select the Indicate objects that cannot be modified check box.

w There is also an indicator showing the objects that can be modified.
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When an object cannot be modified by the current user, a symbol representing a
closed padlock is displayed:

e In diagrams: the symbol g is displayed under the object.
e In atree: the symbol & is displayed on the right of the object name.
When an object is locked, the Immutability attribute displays the "Locked" value.

w This attribute can be viewed in the General tab of the property
page when you are in Expert metamodel mode (Options >
Respository > Metamodel Access > "Expert").

Motives for automatic object locking

There are different reasons for which an object is automatically locked by HOPEX
SAP Blueprint.

An object is locked:
e if a new version of the object has been created.

w  For more information about variations, see "Viewing project
versions", page 53.

e if the object displays a value (any value) in SAP Global Attribute

w  This attribute can be viewed in the Characteristics tab of the
property page.
e if, within the framework of a maintenance project, the object that is part
of a solution is not checked-out. This applies to scenarios, processes or
process steps.

w  For more information about maintenance projects, see "Managing
Maintenance Projects"”, page 52.

e if, when importing a transaction, the transaction parent is locked.

The System Landscape Attributes of a SolMan Project

You can define SAP Components that define a System Landscape from the System

Landscape properties window. This window can be accessed from the SolMan
project.

To define SAP Components that define a System Landscape:
1. Acess a SolMan project.
2. See "Viewing SolMan Projects in HOPEX", page 23.

3. Right-click the SolMan project and in the pop-up menu that appears,
click Properties.

4. In the properties window of the project, select the Defined System
Landscape tab.
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5. To the right of "Defined System Landscape" field, click the arrow [»] and
select Defined System Landscape > Properties.

B Properties of SolMan Project SOLIMP1001 MEGA H=I &3
Contents | Texts |

General | Characterictics  Defined Spstem Landscape | ‘wieb Site Links Synchronization |

Defined System Landscape: ISOLIMPIDDI MEGA v| >| |

Component: & Connect
©ijal| 1 % @l Hew
Local name | SAP Mame SAP Description [l e Disconnect
k- ecd 4P ECC [y Copy
* Add ta Favarites
Delete
@ Explore
Check. 3
Manage 3

The Properties window of the SAP System Landscape appears.

= Propetties of SAP System Landscape SOLIMP1001 MEGA [_ O] x|

General Characteristics | Tenxts |

(T WGBS OLIMP 1001 MEGA
Owner: [5olMan Project ||sotmpiont Meca I
Component
0 & o] R X G
Local name | SAP Mame SAP Descripkion
@ SAPECC SAP ECC SAPECCE.0

Components that define the System Landscape are displayed in this window.

w ]t js highly recommended that you neither add nor delete SAP
Components in HOPEX. This should be done in SAP Solution Manager.
During the next synchronization the System Landscape in HOPEX is
aligned with the System Landscape updated in SAP Solution Manager.

Activating/Deactivating SolMan Objects

SAP provides many Scenarios with many Processes. Not all these objects are
relevant to any given Project. As such, SAP Solution Manager offers the possibility
of activating or deactivating these objects according to Project requirements.
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All objects imported from SAP Solution Manager can be activated or deactivated
within HOPEX. This is done with the "Is Active" attribute that can be found on
objects of the following MetaClasses:
e SolMan Scenario
SolMan Organizational Unit
SolMan Master Data
SolMan Process
SolMan ProcessStep
SAP Transaction
The "Is Active" attribute corresponds to the same attribute in Solution Manager. It
is used to activate/deactivate objects of the SAP system.

To set the "Is Active" attribute:

1. In the Solution Manager navigation tree right-click an object.
2. In the pop-up menu that appears select Inactive.

5 Main Objects | £¥ Prajects E¥ Solution Manager |

ﬁ Adverture
[=15) Projects view
B {z7) SOLIMP1001 MEGA
: ) Objects not present in Sollan
[#-{5y Organizational Units
,3 Master Data
EJ Business Scenarios
(- T% Stare Merchandise Management
) Mapping
{5y Organizational Lnits

SolMan Process

-3 Phy

- Rec

3 sto 0 5 & ({Mone)
= Tra #iky Analysis Discovery E""Cti

ve
- Tra y
[l ver _
(- Sto & Disconnect

External reference Inactive
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The object now appears with a red cross indicating its inactive state. When objects
are Active they are displayed with a green checkmark.

Main Obijects | £# prajects &7 Solution Manager |

i 1 .
E@ Projects view
E-{&7) SOLIMPLO01 MEGA
{5 Objects not present in SolMan
-5y Organizational Units
-5y Master Data
o [B assortment module maintenance
| Assignment maintenance for assortment moduls
{E5) Mapping
&) Astriks I5-R, maint. moduls-» store
@ I5-R Astmts, Display module-> store
] Assorkrment processing
-5 Business Scenarios
- T¥ Stare Merchandise Management
{E5) Mapping
{5 Organizational Units
{5y Master Data
-5 Business Processes
l] Store Price Management
E|l3 Store Promation Management
-{C5) Mapping
& Select promotion
& Display/change promation
@ Confirm promation
[#-{Z) SAP Retail Store_ Promotions
- Physical Inventory
-0 Receiving
+-[0 Store Shrink Management
- Transfers and Returns_planned

The "Is Active" attribute behaves as follows:
e If an object is deactivated, all its sub-objects are inactive.

w  When an object is deactivated, all its sub-objects are seen as
deactivated however their active state is restored when this object is
reactivated.

e If an object is activated, all its super-objects are activated.

w When you activate an object, the objects above this object in the
tree, including the parent object, are also activated.

w The Active/Inactive status associated to each SolMan object
indicates whether or not the object (and its sub-hierarchy) is to be used
in the project. Inactive objects are not used in projects but are still
present in the project and are still exchanged between HOPEX and SAP
Solution Manager. At any moment during the project, inactive objects
can be activated.

Adding SolMan Objects

Project requirements cannot always be met by simply selecting from the standard
objects provided by SAP. Sometimes you may be required to add new objects that
do not exist in SAP. HOPEX SAP Blueprint allows you to insert new objects in the

project hierarchy.
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However, as projects and their System Landscapes must be created in SAP
Manager, the objects that can be added in HOPEX SAP Blueprint are restricted to:

SolMan Scenarios

SolMan Master Data
SolMan Organizational Unit
SolMan Process

SolMan ProcessStep

SAP Transaction

To insert a new object in the project hierarchy:

1.
2,

3.

See "Viewing SolMan Projects in HOPEX", page 23.

In the Solution Manager navigation tree, select the parent object
where the new object is to be inserted.

Right-click this parent object and select the appropriate object type in
the New menu.

=+ Business Scenarios
El-5¥ Store Merchandise Management
-5 Mapping
-5 Organizational Units
__J Master Diata
E|__, Business Processes
[l ] tore Frig "
g Stare pro. 20IMan Process I
-3 Physical Hew SolMan Pro
-3 Receiving
-3 Store Shr

SolMan Process Is Active  » iz S0iMan Transaction

A creation dialog box appears.

Enter the name of the new object in the dialog box and click OK.
The new object appears in the hierarchy

Right-click the new object and in the pop-up menu, select Properties to
open the properties dialog box.
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6. Enter the name of the Component that supports the object (Supporting

Component).

w  You can either create a new component or find a component that

already exists.

w  You can only add supporting components for Process Steps and

Transactions.

® Properties of SolMan ProcessStep Enter Count

General  Characteristics | SAP Tranzactions | Business mapping | Texts |

M=l 3

Local name: I Enter Count

| v

SolMan Foreign Id: I

Supporting Component: I

SAP Mame: I
SAP Id:

v solMan ProcessStep Is Active

Component Mame:
SAP BPR Id:

SAP Area Mame:
SAP Area Id:

SolMan Original Mame: I

SolMan Original Source: I

Soltan Original Type: |

3) Supporting Component

=
=
=

[ 1]

Help |

4

The new object has no SAP IDs. The SAP IDS will be assigned by SAP Solution
Manager during the next synchronization. Once assigned, these IDs must not be

changed.

w When you create new objects, you do not need to explicitly select
the "Is Active" attribute. By default, the object inherits the value of the

parent object.

Retrieving Objects Not Present in SAP Solution Manager

Objects that are present in HOPEX SAP Blueprint but which have been deleted
from SAP Solution Manager can be found in a specific folder during the import from
SAP Solution Manager into HOPEX SAP Blueprint.

if objects are deleted from a project in SAP Solution Manager and this project is then
imported into HOPEX, these objects are not automatically deleted in HOPEX SAP
Blueprint. They are instead marked as unfound in SAP Solution Manager. This is
the case for links between the object and its project.

w These links are displayed in the Solution Manager navigation
window in the "Objects not present in SolMan" sub-folder of a project
folder. All the links that existed on the object before the synchronization
are kept in HOPEX SAP Blueprint. The objects deleted in SAP Solution
Manager are therefore still present and in their original place in HOPEX

after the synchronization.
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Accessing objects deleted from SAP Solution Manager

To access objects deleted from SAP Solution Manager:
) From a project, unfold the Objects not found in SolMan folder.

f3l MEGA (Tutorialy

= Implementation Prajects

| E =) Implementation project 02 (from templ, project 02)
J Dacurmentation

= t present in Sollan

BusinessProcess 02

ProcessStep 02

These objects will no longer be exchanged during an export to SAP Solution Manager
and will not be recreated in SAP Solution Manager either.

You can choose:
e to keep the objects not found in Solution Manager
e to delete them

Deleting the objects not found in SAP Solution Manager

To delete objects that have not been found in SAP Solution Manager:
) Right-click on a project, and select Delete SolMan Objects Not Found
in SAP Solution Manager.

f3l MEGA (Tutorialy
ED Implementation Projects
GIRCIM

! SolMan Project
!

Conclude

Master
g Busine:
.D D Conneck 3

All the objects, documentation types and statuses not found in SAP
Solution Manager are deleted.

w  For more information about documentation types and statuses, see
"Managing MEGA document classification", page 45.

Deleting SolMan Objects

SAP covers a wide variety of business cases, by far much more than a company
needs. As all objects are not necessary for all projects, project teams need to know
which objects will definitely not be used. Once this has been decided, the objects
that do not correspond to the company’s context can be deleted in HOPEX and in
SAP Solution Manager.

The HOPEX SAP Blueprint view is a real hierarchy so deleting one object of this
hierarchy also deletes all its sub-objects at the deepest level.

To delete an object:
1. See "Viewing SolMan Projects in HOPEX", page 23.
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2. In the Solution Manager navigation tree, right-click the object to be
deleted.

3. In the pop-up menu that appears, select Delete.
A deletion window appears. All the objects that will be deleted are
presented with a check box.

4. Click Delete.

The object and all its sub-objects have disappeared from in the Solution Manager
navigation tree.

Mapping SolMan Objects with Business Objects

Objects of the SolMan hierarchy can be linked to objects of the business view
according to the correspondence table below.

B SolMan Concept B HOPEX Concept
Project Library
Scenario Business Process

Organizational Process
Functional Process
Activity

Task

System Process
Business Function
Operation

Process Business Process
Organizational Process
Functional Process
Activity

Task

System Process
Business Function
Operation

Process Step Business Process
Organizational Process
Functional Process
Activity

Task

System Process
Business Function

Operation
Master Data Content

Data Model

Package
Organizational Unit Org-Unit
Transaction IT Service
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Mapping
HOPEX business objects that have been linked to SolMan Objects in the project are
placed in the "Mapping" folders of the Solution Manager navigation window.

Because of this one-to-one correspondence and the related identification issue,
objects cannot be moved around from one place to another in HOPEX SAP
Blueprint. They can only be created, duplicated or deleted.

You can map objects:

e in SolMan diagrams
e in the navigation window

In the navigation window

To map objects in the navigation window:

1. In the Solution Manager navigation window, select the SolMan object
to be mapped and unfold it.
Its mapping folder appears.
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2. In the Objects navigation window, select the business object to be
mapped then, drag and drop it into the Mapping folder of the Solman

object.
5 . . " Solution Manager x
B4 Home £ Main Objects | £ projects | g
_— = ﬁ Adventure
&) Hiring Process =l B3 Prajects view
) H!r!ng RECIU!S!t!UH Formal!zat!on El-{2) BPM-%change Solutionmanager Demo-Project 01
{0 Hiring Requisition Formalization [#-5) Objects not present in SolMan
EHED Import Compliance ¥alidstion @2 | 1 3 Organizational Units
F-§ Flowchart \ ..... [[5) Master Data
"CJ ey SN =) Business Scenarios
[H-{Z) Draft Shipment Approval \‘*—EL? Import - Compliance Management &
) Embargo Validation ) Mapping
{0 Select validation Scenario £ SolMan Diagram
|'i'| Customs administration (3 Organizational Units
|'i'| Cuskoms expert (3 Master Data
: - ADI.JFU\."3| J Business Processes
/ Rejection 11'7_'1_] BPM-¥change Solutionmanager Dema-Project 01.doc
[#- " Shipment
-8 Investment Purchasing Process (ERF)
-8 Investment Purchasing Process (ERF)

The mapping is established.

Solution Manager

ﬁ Adventure
[=1-5) Projects view
E@ BPM-xchange Solutionmanager Demo-Project 01
El.j Objects not present in SolMan
L@ License Type Determination
-{[3 Organizational Units
-{[3) Master Data
=) Business Scenarios
EIE Import - Compliance Management &=
=15 Mapping
EGJ Import Compliance Yalidation &

{0 Classify Shipment

{7 Draft Shipment Approval
{7 Embargo Yalidation

{0 Select validation Scenario
|'i'| Customs administration
|'i'| Customs expert

[, Shiprent

When you map a HOPEX object with an SAP Solution Manager object, its sub-
objects (owned objects) are not automatically mapped with the sub-objects of the
associated SAP Solution Manager object.

In the above example, an organizational process is mapped with a scenario. The
sub-objects of the organizational process are displayed in the Solution Manager
navigation window under the scenario, however, none of them are linked to any of
the scenario’s sub-objects. The sub-objects must be explicitly mapped like the
business object and the scenario, by dragging and dropping the business object
sub-objects in the Mapping folder of the concerned scenario sub-object.

In a SolMan diagram

You can map HOPEX business objects with SAP Solution Manger objects in a SolMan
diagram.
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To create a diagram in HOPEX SAP Blueprint:

1.

2,
3

Right-click the SolMan object that contains the objects to be mapped.
This can be a project, a scenario or a process.

In the pop-up menu that appears select New > Diagram.

In the dialog box that appears, select the SolMan Diagram type and click
on the Create button.

To map HOPEX and SolMan objects:

1.

2,

In the object bar select the icon corresponding to a HOPEX object
(Process, Operation, etc.) and click in the diagram.
Create the HOPEX business objects and place them in a vertical line in
the in the diagram.
e Click the arrow of the Name field and search for the object to be
added in the repository.
m  You cannot create new items in SolMan diagrams. If you want to

add an object that does not exist, you must first create it in the correct
navigation tree.

e Click Connect.

The object appears in the diagram.

Create the SolMan objects and place them in a vertical line to the other
side of the diagram.

In the object bar, select the Link icon and click in the diagram on the
first object to be mapped.

Without releasing the mouse button, draw a line to the second object to
be mapped then release it.

Once mapped, the HOPEX objects appear in the Solution Manager
navigation window, under the SolMan objects.

In the figure below, the "Product Classification (Compliance)" Business
Process is mapped with the "Classify shipment" operation.

_j Master Data
EI_] Business Processes
E@ Product Classification {Compliance)

@ Classify Produck Masker
: @ Reclassify Product Master
[ & Configure Classification Help
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Example of a SolMan Diagram

Clazzify Shipment

Designing for SAP Projects

Product Classification

X

Embarga % alidation

[Complisnce)

v (=]

Select validation
Scenario

Embargo Check
v m

Define Determination

i

?Cusloms administration

Avi

Strategy

SAFECC

Customs

? Customs expert

administration
W

Customs expert
v

Initializing a SolMan Project from Business Objects

A specific wizard enables initialization of contents of a SolMan project from business
objects i.e. HOPEX objects. It consists in transforming a BPMN diagram into a

SolMan structure.

Managing Projects
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Prerequisites
Before launching the wizard, you need to make sure:

e the object from which you want to launch the wizard is already mapped
with a HOPEX SolMan element.

w  For more information on mapping, see "Mapping SolMan Objects
with Business Objects"”, page 35.

In the example below, the "Purchasing" business process is
mapped to the "Credit Risk Management" Solman scenario.

R "
(e} I I 1
| ] | 100% = ‘ o| F- () ) Business Scenatios
a0 "] Documentation
I b — ﬁ El-TF  Credit Risk Management
= IS Purchssing " 1 [ pocumertation
— B[] Mapping
B T
= Operational Purchazs Process L8 Organizational Units
= —_— IS Master Data
- ) I3 Business Processes
v Standard Purchase Process Urgent Purchasing Process “q ) Accaurt Pasling
) Account Poaling-1
&= [ ) Administration of Scenario Runs
= Er ) Basel 11 DfR- Test for BI Extractor
W + :EIQ — @ ZPDP- Aggregation Run

bt S Car Maintenance Depatmert @ Curre o] ) CPDP- Business Partner Extraction
O < - = = P :;; @ ZPDP- Disaggregation Run
O . Purchase - Receipt I e oo @ CPDP- Extraction of Aggr. Exposures

Receipt =] B-{Z} CPDP- Extraction of Exchangs Rates
B- - CPDP- Extraction of Exposures

I A
0 iz) 0o, T {2} CPDP- Extraction of Guarantor
. 2] =+ I +-{7)  CPOP- Extraction of Initiglization

. - W7 CDRD. Fvkrackion oF DM Cride

e you have created a parameter file indicating the mapping levels between
MEGA objects and Solman elements. For more information, see "Creating
a parameter file", page 40.

Creating a parameter file

Before launching the wizard, you need to create a parameter file which specifying
the mapping levels between MEGA objects and Solman elements.

Location of the parameter file

The "megasolmanbusinessimport.ini" file should be located in the USER folder of the
appropriate environment:

<Environment>\Db\<Repository>\USER\<User name>

Syntax used
Parameterization is found in a [MetaAssociationEnd] section.

HOPEX SAP Blueprint



The syntax is as follows:
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[Metaclass field] =[MetaAssociationEndl

field] ; [MetaAssociationEnd2 field] ; [MetaAssociationEnd3

field]

w  The list of MetaAssociationEnds are those to browse from the
MetaClass occurrence. The sub-objects taken into account are those

obtained by the defined link.

w A * sign before the MetaAssociationEnd means there is a change in
mapping level.

No change in mapping level

The SolMan element created is of the same type as the
SolMan element mapped with the parent MEGA object.

Change in mapping level (* before
the MetaAssociation)

The SolMan element created is of a lower level than the
SolMan element mapped with the parent MEGA object.

In the event of a change in mapping level:
e If the owner was mapped wih a SolMan Scenario, the object is mapped
with a SolManProcess

e If the owner was mapped with a SolMan Process, the object is mapped
with a SolMan ProcessStep

e if the owner was mapped with a Solman ProcessStep, the object is

mapped with a SolMan Transaction

Example
[MetaAssociationEnd]

Managing Projects

~pj)grmQ9pG9O0[Business Process]=~Zs()h50XBn70[Owned Business
Process]; *~6R65VIXKpG10[Organizational Process]

~gsUiU9B5iiR0[Organizational Process]=*~prUiaCB5iOB2[Operation]
w [n the above example the sub-processes of the process from which

you want to initialize the wizard must be owned by the process.

Launching the wizard

To launch the wizard:

1. Open a BPMN diagram, for example a business process diagram.
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2. Right-click on the root HOPEX object from which you want to initialize
the Solman project and select Initialize Solman Project.

b1 Purchasing T
/ Operational Purcha: [E<) Business Process Diagram
Previgw...
Standard Purchase Process Mew 4

Connect 3

3 Consolidate

& Dependency and Impact

Sirmulate 3

Animnate

= Absolute Risk Map

7 Repart Discovery

ii Copy

w The HOPEX object from which you want to initialize the project
must be already mapped with a Solman element. For more information,
see "Prerequisites”, page 40.

For this object and all the sub-objects below, an object is created in the
Solman hierarchy.
In the example above:

- A business scenario named "Purchasing" is created and
mapped with the "Purchasing" business process.

- A business scenario named "Operational Purchasing" is
also created and mapped with the owned business process
"Operational Purchasing"

- A SolMan Process named "Standard Purchase Process" is
created and mapped with the organizational process
"Standard Purchase Process"

Hierarchy of SolMan objects created

The Solman hierarchy is created according to the structure defined in the parameter
file.

w For more information about the parameter file, see "Creating a
parameter file", page 40.

A business process produces a scenario.

The sub-processes could produce:
e a SolMan Scenario if there is no change in mapping level
e a Solman Process if there is a change in mapping level (*)

w  You can launch the wizard several times while designing your
diagram. Updates in your diagram are transfered to your new SolMan
structure.
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Generating a report

A report gives you an overview of the business objects that have been mapped to a
SolMan object.

w  For more information, see "Solman Project Mapped Element
Report", page 71.

Populating a BPMN Diagram from a Solman Structure

You can update a BPMN diagram by drag and dropping elements from a Solman
structure.

To update a BPMN diagram:

1. From the Solution Manager navigation window select an element and
drag it to the BPMN diagram you want to update, for example a business
process diagram.

A wizard asks you which object type (metaclass) you want to use to create
the corresponding object.

m Mega SclMan Diagram Drop - Select a MetaClass @

Please select the MetaClass for the new mapping object.

Mapping MetaClass:
L3 RE
MName

(T Operation
(@ Organizational Process

2. In the Mapping Metaclass frame, select an object type, for example
"Functional Process".
A new object is created, with "SAP" indicated on the shape.

Credit Portfolio 0 ata
Frocessing with stressed

3. Create in the same way the different objects needed in your diagram.

w [f at some point you cannot drag-and-drop objects, close your
diagram and reopen it.

4. Arrange your diagram and create links betweens objects accordingly.

w If you try to drag-and-drop an object that has already been created
in the diagram, the wizard asks you if you want to:

. create a new mapping object
. use an existing mapping object

w [f you delete an object in the HOPEX SAP Blueprint hierarchy, the
corresponding object in the BPMN diagram is not deleted.

You have created a BPMN diagram from a SolMan structure.
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Exchanging Documents Between HOPEX SAP Blueprint and SAP

It is possible to:
e create links to the URL documentation of SolMan objects so that they can
be viewed from SAP Solution Manager
e access SAP Solution Manager documents of URL type from HOPEX SAP
Blueprint through external references
e categorize the documents sent by HOPEX SAP Blueprint according to
SAP classification.

Creating links to the URL documentation of SolMan objects
You can create links to the URL documentation of SolMan objects allowing you to
view these in HOPEX Explorer.
To activate links to the URL documentation of SolMan objects:

) In the properties dialog box of SolMan projects, select the Website Link
Synchronizaton tab.

=i Properties of SolMan Project BPM-Xchange Solutionmanage - 10| x|

Contents | SolMan Documentation Comment |
General | Characterictics | Defined System Landscape  'Web Site Links Synchronisation

[V Pctivate Dynamic Website Links Generation!
Dynamic WebSike Url Rook: I Ikkp: ffdwafadvisor

I™ Activate Static WebSite Links Generation
Static WebSite Url Root: |

The generated links are a result of mapping links in HOPEX.

Example

If in HOPEX a SolMan Scenario is mapped with an organizational process, a
documentation link towards the HOPEX Advisor page of the organizational process
is added in SAP Solution Manager at the next synchronization of the corresponding
Scenario.

Pointing to dynamic Web sites

You can point to a dynamic Web site (HOPEX Adyvisor).

To specify access in SAP Solution Manager through dynamic Websites:
} Select the Dynamic WebSite Links Generation check box.

To specify the root address of dynamic websites:
) Enter the URL address in the Dynamic WebSite URL Root field.

Pointing to static Web sites
You can point to a static Web site.
To specify access in SAP Solution Manager through static Websites:
) Select the Activate Static WebSite Links Generation check box.

HOPEX SAP Blueprint
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Accessing SAP Solution Manager Documents from HOPEX SAP Blueprint

SAP documents of URL type appear in HOPEX SAP Blueprint as external
references after being imported from SAP Solution Manager:

B Business Processes
J Documentation
-0 BusinessProcess 01 &

[ ) Documentation

) Mapping

[+ & ProcessStep 01 @
=) Documentation

[ @"ﬂ CopyoFOperation-ChargeCustomer]

E-2) Mapping

E@ Display SAP Directories
B3 Mapping

These external references appear if you have:

e created documents for SolMan objects in SAP Solution Manager
e mapped SolMan objects with HOPEX business objects

Managing MEGA document classification
In SAP Solution Manager, documents have a specific classification.

By default, MEGA documentation originating from mapping is classified under
"Additional documentation". You can categorize MEGA documents so that they
appear in one of the categories of the SAP Solution Manager project.
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Viewing document classification

To view the documentation statuses and types available on the SolMan project:
) In the SolMan project properties dialog box, select the Documentation

Classification tab:

B2 Propetties of SolMan Project Maintenance project 01 (from imp. project ; ... =] E3

‘wiebSite Synchronization | Contents | SolMan Documentation |
General Characterictics | Defined System Landzcape | ‘wieb Site Links Synchronization |
Soltan Project Transaction Launch Documentation classification Comment |

Available SolMan Documentation Status:

SolMan Status Description |SoIMan Skatus Key |
= Copy Editing COPY_EDITING

= Fifty percent done Z_50%_READY

= In Processing IN_PROGRESS

= Released RELEASED

= Review REVIEW

Available SolMan Documentation Type:

SolMan Type Description

SolMan Type Key

= Additional Documentation
= Business Process Procedure
= Configuration Guide

= Configuration Reference
= Installation Guide

= Interface Farm

= Cther Devoplement Form
= Process documentatn

= Program Development Form

AD -
BFP

CFia

COFG

I

IF

QDF

PCOC

FDF Lll

QK I Lancel | Apply Help |

4

w  The values are those created initially in SAP Solution Manager.

Specifying document classification
You need to specify the default classification of documents on the project.

To specify the default classification of project documents:

1. In the properties dialog box of a SolMan project, select the Website
Link Synchronizaton tab.
2. Specify:

e SolMan Default Document Status
e SolMan Default Document Type

You can also modify the classification on an individual document.

To modify classification of HOPEX documents on an external reference:

1.

in HOPEX SAP Blueprint, from a SolMan object, unfold the
Documentation folder, right-click the external reference and open its
properties dialog box.

You can modify the desired values for:
e Solman Document Status

e Solman Document Type

HOPEX SAP Blueprint



Designing for SAP Projects
Managing Projects

2. Select another documentation type.

'Ea Properties of External reference TestDoc

General | Characterisice  SolMan Documentation | Texts |

SolMan Project Documentation Stakus: |In Processing j

SoliMan Project Documentation Type:  [GHNone)
Copy Editing
Fifty percent done

Example of values for Solman Project Documentation Status

w  Note the values are those created initially in SAP Solution Manager.

When data is exported, the documentation classification value is modified
accordingly in SAP Solution Manager.
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When a project changes statuses during its SAP lifecycle, new objects are created.
The issue here is that HOPEX mapping is lost.

As a consequence, it may not be possible to use the initial documentation produced.
w  For more information about mapping and documentation, see :

. "Mapping SolMan Objects with Business Objects", page 35
. "Exchanging Documents Between HOPEX SAP Blueprint and SAP",
page 44.
HOPEX SAP Blueprint provides a means to trace the changes back to the initial

implementation projects through versioning.

w  Versioning is a HOPEX platform feature that is fully described in
the HOPEX Common Features user guide. For more information, see
chapter "Handling Repository Objects", paragraph "Object Versions".
See also "Viewing project versions"”, page 53.

Overview of SAP Solution Manager Lifecycle

The following summarizes the main project types found in SAP Solution Manager.

MEGA Solution Manager
Implementation Operations

Maintenance
Proiect

e Implementation

ﬁ-’/ —4 | Project |
MEGA Solman —— —

Process Model 3

inl

- Template

:I-'I?Yfgi\?v} = J|| Project
Import/
Export

Mapping |
W

Process Model
X levels

(Business View)

v "Managing Implementation Projects", page 49
v/ "Managing Maintenance Projects", page 52
v/ "Managing Template Projects", page 55
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Managing Implementation Projects

The lifecycle of an SAP solution typically starts with an implementation project
for blueprinting, customizing, developing, testing and roll-out (which is reusing
existing implementation in a new location).

An implementation project is used to implement business processes
in an SAP landscape.

After an implementation project is carried out, it becomes a solution in SAP Solution
Manager.

Importing a project
For more information on project import, see "Importing/Exporting"”, page 14.

Viewing the differences with the template project

If the implementation project is based on a template project, HOPEX SAP
Blueprint allows you to view the differences between them.

When importing the implementation project, versions of the project are created to
track the changes made in relation to the originating template project.

Technically speaking, versioning involves:

e creating variations
e locking the versioned object.

You therefore need to be able to view variations.
Viewing variations

To be able to view versions, you need to activate variations (as versioning relies
partly on variations). For more information, see "Activating Variations", page 12.
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To view an object version:

} In the property page of a the SolMan project select the General tab then
the Variations sub-tab.

¥ Properties of Procurement and Logistics Execution Processes in ERP

SolMan System Attributes | Texts |
General | Characteristics | S&P Transactions | Contents | Business mapping | Soltdan Documentation | Soltdan Differences |
Adminiskrati
e | ‘ariant Object: Waried Object:
Motes s E ) = E &
= 4L hWuBP X + £ G| B P X8|
Imnpacts 7 H
= TP Procurement and Logistics Execution Processes in U Procurement and Logistics Execution Processes in
Histary E|: Yariant Side Variation (1)
References El-1 variation
. E|: Waried Object

=15 SolMan Scenario (1)

Rules Application
A= AfpfpIEE e | TP Procurement and Logistics Execut

‘Wariations

K1 L I K i

-

onk

1. Inherited, Removed and Replaced Items ®

" The sub-item is directly linked to the studied item. —
+" The sub-item is inherited from an ancestor (its name is displayed just after the symbaol).
> The sub-item is excluded or replaced.

QK I Lancel Apply Help |

Viewing the differences via a report
Versioning makes immediate change impact analysis possible.
Reports make it easier to view the differences between objects.

To access a report from the implementation project level:

1. Right-click the implementation project and select Report Discovery.
2. In the Available reports section, select SolIMan Analysis.
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3. Alongside the SolMan Analysis Differences on Hierarchy report,
select Launch a new report.

2. Available Reports ®

E Context Analysis
E Dependency & Impact

B Platform Tools
This folder contains all analyses used as tools to help the MEGA user in her/his modeling tasks.

E Simple Reports

E SolMan Analysis

" sap Analisys
Differences On Customize & Launch a new report ELaunch a new report

Hierarchy

4. Click the title "Differences on Hierarchy" to refresh the report.
The implementation project is a variant of the corresponding template
project. The report shows the differences between them and their sub-
elements.

w  For more information onthe contents of this report, see "Hierarchy
Differences Report", page 75.
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To access a report from a lower level element, for example from a a SolMan
Business scenario:

) Open the properties dialog box of the object and click the SolMan
Differences tab.
The report shows the differences for the object and its first-level children.

¥ Properties of Credit Risk Management =] E3
General | Characteristics | SAP Tranzactions | Contents | Business mapping | SolMan Documentation |
Soltdan Differences | Texts |
N
(G ] -}

1. Differences On Object

- Credit Risk Management is a variant of Presales Project template with template::Business
Scenarios::Credit Risk Management

Type”™ |Name™ MetaClass™

- Deleted | &) generic Market Data- Edit Scenario  |50IMan Transaction
+ Created|{Z) Account Pooling SolMan Transaction
+ Created| &) extraction with Delta WL + SDLTs |S0IMan Transaction
+ Created| ) cppp- Extraction of Exposures SolMan Transaction
+ Created|{Z) cppp- Extraction of Guarantor SolMan Transaction
+ Created| &) gagel 11 D/R- Test for BI Extractor |>0/Man Transaction
- Deleted | &) cppp- Extraction of PD Grids SolMan Transaction
- Deleted | &) pdministration of Scenario Runs SolMan Transaction

- Deleted | ) cppp- Extraction of Guarantor SolMan Transaction LI

QK I Lancel Apply | Help |

4

m  For more information on the contents of this report, see "Object
Differences Report", page 74

w If you want a more global report on the whole project, see
"Hierarchy Differences Report", page 75.

Managing Maintenance Projects

In the lifecycle of an SAP Solution Manager project, any change to the solution has
to be managed by a separate maintenance project.
w A maintenance project is used to maintain changes in the
productive environment (solution).
The branches of the business processes that need to be changed are checked-out
from the solution into the maintenance project.
The project is then modified according to the required changes. After all changes
have been implemented, corresponding maintenance projects are checked-in back
to the solution.
Maintaining a SAP Solution Manager project therefore requires importing the
maintenance project into HOPEX SAP Blueprint.
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HOPEX SAP Blueprint keeps tracks of the changes to be able to update the
implementation project that gave birth to the solution.
Note that the objects of a scenario that are not checked-out are locked.

Importing a project
For more information about project import, see "Importing/Exporting"”, page 14.

Viewing project versions
When importing the maintenance project, versions of the project are created to
keep track of the changes made in the maintenance phase.
Technically speaking, versioning entails:
e creating variations
e Jocking the versioned object.
You therefore need to be able to view variations. For more information, see "Viewing
variations", page 49.

w A report makes it easier to view the differences between objects.
For more information, see "Object Differences Report"”, page 74

Flagging objects for check-in
After you have modified an object in the project, you need to specify it is ready for
check-in in order to link it to the maintenance project.

w  This step is necessary so that when concluding the maintenance
project the objects are traced back to the corresponding implementation
project.
To flag the object for check-in:
) Right-click the object modified and select SoIMan maintenance > Flag
for check-in.

B3 Business Scenarios
ocumentation
Procurement and Lg
Documentation
Mapping Mew »
Organizational |
Master Data
Business Proce: 5y Consolidate

BT SolMan Scenario-1 SolMan maintenance Flag for check in
7 Report Discovery Cancel check in
Check-out status

The object must be in a proper check-in status to be flagged for check-in.
The statuses that are entitled for flagging for check-in are as follows:
e Check-in confirmed
Check-in ready
Check-out confirmed
Check-out requested
Checked-out

SolMan Scenario

SolMan Scenario Is Ackive  #
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If the object has a different status, a warning indicating that the check-out status
does not allow flagging for check-in appears.

w  You can view the SolMan Checkout status in the Characteristics
tab of the object property page.

Canceling check-in
You may decide later on that the object is not ready for check-in.

To cancel check-in:
) Right-click the object that was flagged for check-in and select SolMan
maintenance > Cancel check-in.

Concluding a project

To conclude a maintenance project:
) Right-click a project and select Conclude.

|1 SelMan Maintenance Project Conclude @

The SolMan Maintenance Project is about to be concluded.
Object flagged for check in will be checked in and the maintenance project will be empty.

Maintenance elements ready for check in:

MName MetaClass Status
[ BusinessProcess 01 SolMan Process Ready
@ ProcessStep 01 SolMan ProcessStep Already in check in path

The objects that have been flagged for check-in are checked to the
solution.

m  The objects that are already in the check-in path (meaning their
parent is already flagged for check-in) are not processed here.

Impact of maintenance project conclusion on the implementation project
The implementation project is updated with the elements that were flagged for
check-in during the maintenance phase.
The maintenance project in HOPEX SAP Blueprint is emptied.
When you update an implementation project from a maintenance project:
e varied objects are disconnected
e variants are connected

w  Traceability is kept in case you need to produce reports following
project conclusion.
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Managing Template Projects

In complex environments with for instance several locations with country-specific
differences, several implementation projects may derive from a common template
project.
A template project is used to create and distribute a template
defining the project structure.
Deploying a template project is a way to transform a project into a solution. When
a template project is deployed, the global processes defined in the templates are
said to be "localized".

w Managing SAP template projects and maintenance projects is very
similar, except that the scope is larger when managing template
projects.

Importing a template project
When you need to modify a template project in SAP Solution Manager after it has

been deployed (that is to say used for other projects), you have to import it into
HOPEX SAP Blueprint.

Here is what occurs in HOPEX SAP Blueprint when the template project is
imported.
e HOPEX SAP Blueprint detects the template project has been used for
an implementation project.
The template project is locked against changes made in other projects.
A new version of every object of the template is created.
Then you can make changes to the template project without impacting the original
implementation project.

w For more information about project import, see "Importing/
Exporting", page 14.

Project template versions

In HOPEX SAP Blueprint you obtain multiple levels of versions, as shown in the
figure hereafter.
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Template
Project

Version 2

Implementation
#3
Implementation
#2

A new version of the project template is created when:

e you import or synchronize a project template that has given birth to an
implementation project
e you import an implementation project based on a template project
w In the latter case, HOPEX SAP Blueprint connects the
implementation project objects to the processes initially described in the

template project. HOPEX SAP Blueprint creates new versions of the
objects for each modification made in the new project.

Implementation
#1

Accessing previous versions of template projects

Template contents is versioned in HOPEX SAP Blueprint after each new
implementation, that is to say after you have re-imported the project template into
HOPEX SAP Blueprint.

To access the initial template project :

1. see "Viewing SolMan Projects in HOPEX", page 23.
2. In the Template project folder, unfold the Previous version folder.

E)  Template Projects
=1z \ Template project 01-1

#-) Documentation

#-) Objects not present in SolMan

=) Previous Yersion

-4 Documentation

Objects not present in SolMan

Previous Version

Ready for checkin

Organizational Units &

Master Data @

#-{) Business Scenarios @
Ready for checkin
Organizational Units
Master Data
Business Scenarios

9E3 o
ooooo

0

-G
vouw
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DOCUMENTATION IN HOPEX SAP
BLUEPRINT

When company projects include a lot of information, it is important to be able to consult this
information easily and if possible in different formats. HOPEX offers the possibility of generating
different documentation for the different projects in the company. The documentation can then be

managed and distributed as desired.

v "MS Word Report Generation", page 58
v "Static Web Sites in HOPEX SAP Blueprint", page 59

v "Report Generation", page 62

For more information about documentation exchanged between HOPEX
SAP Blueprint and SAP Solution Manager, see "Exchanging Documents
Between HOPEX SAP Blueprint and SAP", page 44

57



58

MS WORD REPORT GENERATION

In HOPEX, you have the possibility of generating reports (MS Word) of your SolMan
Project.

To create a report (MS Word) of a SolMan project:

1. In the SAP Solution Manager navigation window, right-click the folder of
the project concerned and in the pop-up menu that appears, select New
> (MS Word) Report.

The creation dialog box appears.

2. In the Name field, specify the name of the report (MS Word) to be
created and select From report template (MS Word).

3. Select "SolMan Project Documentation" and click Next.

The created report (MS Word) is based on this template.

4. Specify the location in which the created report (MS Word) is to be
stored and click Next.

w If you so desire, in the dialog box that appears, you can enter the
report (MS Word) distribution list. For more details on creating
distribution lists, see the "HOPEX Common Features" user guide,

"Generating Documentation" chapter, "Creating a Distribution List"
paragraph.

5. Click Finish.

The report (MS Word) is created in the Documentation navigation window,
Reports (MS Word) folder.

It is automatically generated when created and opens. A specific toolbar and a
HOPEX menu appear in the report (MS Word).

You can do several things to the generated report (MS Word):

e Update it

e Revise it

e Distribute it for Review or Validation
e Detach it from MEGA

w  For more details on these options, see the "HOPEX Common
Features" user guide, "Generating Documentation" chapter.
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STATIC WEB SITES IN HOPEX SAP BLUEPRINT

HOPEX offers the possibility of generating static web sites of the SolMan project.
This allows you to distribute the content of projects to enable people without access
to HOPEX to consult the objects of a project.
The generated web site is based on a web site template.

w |Veb sites can be generated in HOPEX Windows Front-End only.

Creating a Web Site

w This feature is not available in HOPEX Web Front-End.

To create a web site of a SolMan project:
1. In the HOPEX desktop, select the Documentation navigation window.

w (Windows Front-End) If the Documentation navigation window is
not visible in the workspace, in the HOPEX menu bar select View >
Navigation Windows > Documentation.

2. In the tree, right-click the "Web Sites" folder and select New > Web
Site.
The Create Web Site dialog box appears.

Enter the name of the Web site to be created.

Select a folder for generation by clicking the El button.

By default, the Web site is generated in the "Intranet" folder. You are
advised to create a sub-folder for each generated Web site, for example
by creating folders with the same name as your Web site in the "Intranet"
folder.

w  The content of the "Intranet” folder is deleted at each generation so
when you have obtained a site with which you are satisfied and want to
keep, copy it to another folder.

5. In the From Web site template list box, click the E| button.
6. Select the "Enterprise Portal" Web site template and click Finish.

The new web site appears in the Documentation navigation window in the Web
Sites folder.

The new Web site has been created but not generated.

Before generating the Web site, you have the option of restricting the type of
objects to be included in the Web site. For example, you can decide to only generate
a project. If not, the Web site generation will include the entire repository and the
generation time will be lengthy.
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Generating a Static Web Site

To generate the static Web site:

1. In the Documentation navigation window, right-click the new web site.
2. In the pop-up menu that appears, click Generate.

A dialog box indicates the progress of the generation. When the web site has been
generated, a dialog box proposes opening the web site.
w  You can open the generated Web site at any time from the

Documentation navigation window. In the Web Sites folder, right-
click the Web site and in its pop-up menu select Open.

Accessing the Web Site

To access SolMan project information:
) From the generated Web site click the SolMan tab.

T Shy re mgt\"

Organization IT Architecture Processes Compliance Risk Management SolMan

Reporting Cverviews

SolMan Index
an Details

MEGA Enterprise Portal:

R

HITECTURE

The generated Web Site presents a view of the objects in the repository at the time
of the generation. Objects cannot be modified in the Web site. You can however
regenerate the Web Site at any time to include modifications made to objects in
MEGA repository.
To navigate the Web site:

) Click on the links of each object which gives access to the corresponding

pages.

To return to the page previously consulted:

) Use the Back button in the main menu.
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Example of a static web site with a SolMan project

Organization IT Architecture Processes Compliance Risk M

SolMan SOLIMP1001 MEGA

Definition Defined Systermn Landscape | Contents SolMan Wiew

MName

D Store Merchandise Management

MName
& Client
& sales office

MName
(8 szsortment module maintenance
=] Assignment maintenance for assortment module

[=] Assortment processing
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REPORT GENERATION

In HOPEX, you can group sets of repository objects and study the interactions of
these objects to produce different reports. Reports are created from predefined
report templates.

Several report templates are provided with HOPEX SAP Blueprint.

m  You can also create your own reports using the templates provided
by HOPEX. The templates are available in HOPEX Windows Front-
End in the Utilities navigation window of the HOPEX workspace.

w  For more information on creating reports, see :
. "Managing reports (Windows Front-End)", page 314
. "Managing reports (Web Front-End)", page 325

To access a SolMan report from an object:

1. In the Solution Manager navigation window, right-click the object on
which you want to base the report (SolMan Project or mapped
Organizational Process for example) and select Report Discovery.

A page appears with the list of all the reports available for the object.

2. Select the SolMan Analysis folder.
3. Click the Launch button next to the name of the report.
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The report is launched.

Available Reports

@

2. Available Reports

@

] Context Analysis

] Enterprise Architecture Management

] Exchange Balance and Compliance Analyses
5 Fea

] Monitoring

] Process Analysis

la Requiremnent Management

o] SolMan Analysis

SAP Analysis of an Organizational Process Customize & Launch a new report | Launch a new report |

w  You can also modify the report by clicking the Customize and
Launch a new report button.

The report appears in the central window of the HOPEX workspace.

Report Generation

Reports for Organizational Processes

There are four reports available:
e Report Parameters
e SAP coverage rate
e Services of the organizational process
e SAP coverage

You can open a report by clicking on its name.
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Report parameters

LR

[Add a cormment for this report]

s | Organizational Process

Parameter Yalues
# | Mame Walue

1 L Organizational Process (@ Import Compliance Validation

This report indicates the input data used for the report. In this example, this data
comes from the Import Compliance Validation organizational process.

SAP coverage rate
2.Coverage Rate __/1-
[Add a cormment for this report]

This figure presents the percentage of operations within the Organizational Process depending on the supporting tools
SAP Support
Other Systems
Mo IT Support
[25% - 0% - 75%]

This figure presents the percentage of operations mapped with SolMan through the implemented services,

SAP Support
Other Systems
Mo IT Support

[25% - 50% - 25%]

This report indicates the percentage of operations mapped to the SolMan project
through implemented services.

There are two parts to this report. In the first part, the legend is interpreted as
follows:
e SAP Support: percentage of operations that implement a service and are
mapped with a transaction
e Other Systems: percentage of operations that implement a service but
which are not attached to a transaction
e No IT Support: percentage of operations that do not implement a service

In the example above, there are four operations. One operation implements a
service (SAP Support = 25%) while three operations do not (No IT Support = 75%).
There is no operation that implements a service and is not attached to a transaction
(Other Systems = 0%).
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The second part of the report has a different interpretation:

e SAP Support: represents the operations that are mapped with a SolMan
object and implements a service which is mapped with a transaction

e Other Systems: represents all the operations that are mapped with at
least one SolMan object

e No IT Support: represents all the operations of the organizational
process that are not mapped with a SolMan object (process, process
step, etc.)

Services of the organizational process
3.Services of an Organizational Process %)

[Add a comment for this report]

(@0 1ssusPurchase Order

Operation IT Service
™) Embargo Walidation

) Select validation Scenario Licence identification
[T Classify Shipment
[T Draft Shipment Approval

This report lists all the operations of the organizational process and indicates the
services implemented by each of these operations.

65



SAP coverage

The information of this report is arranged in tables.

4. SolMan Coverage Y

[Add a cormment for this report]

The table presents the SAP Transactions used by the operations through the implemented services,

) Classify () Draft Shipment () Embargo ) Select validation
Shipment Approval Validation Scenario
@ License Type Licence identification

Determination

The table presents the mapping beetween the operations and the objetcs SalMan,
SolMan Process SolMan Transaction
@ Product Classification {Compliance)

[0 Embargo Check

SolMan ProcessStep SolMan Transaction
@ Classify Product Master ) Change Product Master

) Display Product Master

@ Define Determination Strategy ) License Type Determination

The table presents the objects SolMan mapped by the operations,

) Classify () Draft Shipment () Embargo ) Select validation
Shipment Approval Validation Scenario

[ Product Classification
{Compliance)

[sJC |assify Product Master &} Change Product

Master
) Display Product
Master
Embargo Check
@ Define Determination @ License Type
Strategy Determination

This report is divided into three parts:

e a table that indicates the services implemented by operations and the
SAP transaction to which the services are mapped.

e a list of the SolMan processes that are mapped with an operation. It also
lists the processes mapped with an operation the transactions of these
processes.

e a table that recapitulates the first two parts of the report by displaying
mappings between the SolMan objects and the operations.

SolMan Updating Report

The SolMan Updating Report displays the changes made to SolMan projects from a
particular point in time in the current HOPEX transaction.
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Two parameters are considered for the report:
e A particular SolMan project

e A schedule (optional). If the schedule parameter is not defined, the
report will show all modifications of the current transaction. All
modifications will be displayed as "New" objects if the SolMan project
was created in the current transaction.

The updates presented in the updating report therefore relate to:
e A MEGA object, in this case the SolMan project

e A dispatch: in this case only the updates relating to the dispatch are
presented

e A schedule: this is used to define a period for the data extraction. If no
end date is specified, the extraction concerns all updates from the start

date. If a dispatch takes place the period defined by the schedule is not
taken into account.

The SolMan Updating Report is generated on SolMan projects. You must launch the
generation from the SolMan project folder in the SolMan navigation window.

There are two reports available:

e Report Parameters
e SolMan Updating

The SolMan Updating Report displays the project information in a tree.

=-{=7) BPM-¥change Solutionmanager Demo-Project 01
) Objects not present in SolMan
+-{5 Organizational Units
+-2) Master Data
=I-{5) Business Scenarios SolMan Updating
+-_) Docurnentation
=¥ Import - Compliance Management &
+-[25) Documentation This tree presents the updating for a SolMan Project
+-12) Mapping ; .
-2 SolMan Diagram E- =) BPM-%change Solutionmanager Demo-Project 01
+- 2] SolMan Scenario Diagram
¥
¥

Analysis Input

B- D Business Scenarios
=3 Crganizational Units

) Master Data E- ¥ Impart - Compliance Management
() Business Processes
+-_) Docurnentation
=3 Product Classification {Compliance) B
[ Documentation B @ product Classification {Compliance)
+-I_) Mapping
+- @ Classify Product Master
+- @& Reclassify Product Master
+- @ Configure Classification Help
+-3 Sanctioned Party List Screening
+-3 Embargo Check B
+-3 Import Control & o Embargo Check
+ .Eﬂ BPM-¥change Solutionmanager Demo-Project 01,doc
+-|=r) TMIDEVELDOS

B L3 Business Processes

5 @ Import Control

B ® Classify Product Master
@ Reclassify Product Master

- @ Configure Classification Help
5 @ Sanctioned Party List Screening

Mew Object, This object has been created and linked.

Mew Object, This object has been linked,

Deleted Object or Unlinked Object.

Modified Object. Characteristics of the object has been modified.
Modified Object. Components of the object has been modified.

il 1 O e O 1

Modified Object. Characteristics and components of the object has been modified.
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|=7) BPM-¥change Solutionmanager Demo-Project 01
I2) Objects not present in SallMan
# |5 Organizational Units

#|[5) Master Data

= |5) Business Scenarios
+-12) Docurnentation
= & Import - Compliance Management B

T

F| B

The updates carried out on the SolMan project are indicated by specific icons. The
icons displayed depend on the type of changes made. The changes can include:

e Component and/or characteristic modifications to objects

e Creation or linking of objects

e Deletion or unlinking of objects

The icons are displayed in front of the object that has been modified.

If an object in a project has been modified, an icon indicating that a change has
occurred appears in front of the project folder. Expand the project until you reach
the object that has been modified/created/deleted.

When an object has been modified, an "Updating" folder is displayed under the
name of this object. This folder contains specific details relating to the modification:
e The attribute that was modified
e The date of the change
e The user who made the change

Analysis Input

Soltan Updating

() Documentation This tree presents the updating for a SolMan Project
=) Mapping f
£g] SolMan Diagram ='a B BPM-Xchange Solutionranager Dema-Project 01

24| SolMan Scenatio Diagram
15 Organizational Units
® |5y Master Data

=2 3 Business Scenarios

SR Import - Compliance Management

= |C5) Business Processes =S D Business Processes

& -ﬂﬂ BPM-%change Solutionmanager Demo-Project 01.doc

+-/2) Documentation
= & Product Classification (Compliance)

F- 00 Import Control

+2) Docurnentation E- J @ product Classification (Compliance)

-2 Mapping @ Classify Product Master

# @ Classify Product Master ..‘J © Reclassify Product Master

# @& Reclassify Product Master .

+ @& Configure Classification Help =5 @ configure Classification Help
#-[@ Sanctioned Party List Screening Eh Updating

+ -3 Embargo Check

# @ Import Control 2 SolMan ProcessStep Is Active 2009/05/20 16:48:18 Mister Guide

57 TMIDEVELOOG

[u

" @ Simulate Classification Help
" @ Generate Search Terms
-- @ sanctioned Party List Screening
-- o Embargo Check

MNew Object, This object has been created and linked.

MNew Object. This object has been linked.

Deleted Object ar Unlinked Object.

Madified Object. Characteristics of the object has been maodified.
Modified Object. Components of the object has been modified.

[l

Modified Object. Characteristics and components of the object has been modified.

Example of SolMan Updating Report with Updates

In the above example, the "Reclassify Product Master" and "Configure Classification
Help" transactions were altered in the project. They were made inactive.

This is indicated in the "Updating" folder. The value for the "SolMan ProcessStep Is

Active" attribute is set at "U" for inactive. When the attribute is set to "Active" the
value is "A".
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Using the schedule

Using the schedule in the SolMan Updating report allows you to:
e Attach a dispatch to your report. This shows everything that was done in
the current transaction.
e Base the report generation on a specific time period. This allows you to
see what was done during the specified time period.
w By default the report is based on what happened during the current
transaction.
To set the schedule parameter for the updating reports:
1. From the SolMan project pop-up menu, select Report Discovery.
2. In the Available reports section, select SolIMan Analysis.
3. Next to the report for which you want to set the calendar parameter
select Customize and Launch a new report.

Available Analyses Elf

|Ana|ysis Input |

Available Analyses

List of all analysis templates able to handle sormme MEGA objects as one or more parameter values,

I salMan Analysis

SAP Analysis SolMan Updating Mody
SAP Analysis SolMan Updating Mapping Modify

4. In the Properties dialog box of the report and in the Parameters tab,
select the Schedule sub-tab.
5. In the Schedule section, click Connect and in the query dialog box that
appears select the schedule desires and click OK.
6. In the list of results, select the desired schedule and click OK.
w  You can also create your own calendar. See "Creating a schedule”,
page 69.
The Schedule appears in the Properties dialog box of the report.

Creating a schedule

m To create a schedule, you must first ensure that you at least have
"Advanced" Metamodel Access rights to the repository you are using
(Tools > Options).

m  You can create schedules in HOPEX Windows Front-End only.

To create a schedule:
1. In the Utilities navigation window, right-click the Schedule folder and
select New > Schedule.
2. Name your Schedule and click OK.
The new Schedule appears in the Utilities navigation window in the

Schedule folder.
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3. Open the Properties dialog box of the schedule and in the

Characteristics tab indicate the Start date and if required, the End date
of the schedule.

4. Click OK when finished.
Your schedule (calendar) is ready for use.

SolMan Updating Mapping Report

When you launch the SolMan Updating Mapping Report, two reports are available:
e Report Parameters
e SolMan Updating

Similarly to the SolMan Updating Report, the SolMan Updating Mapping report
presents the updates made to SolMan projects from a particular point in time in the
current HOPEX transaction.

This report also displays the mapping relations in the SolMan project and the impact
of the different updates on the mappings between:

e HOPEX objects
e SolMan objects.

The mapped HOPEX objects appear in the tree in the list under the SolMan object
with which it is mapped.

=-{=) BPM-¥change Solutionmanager Demo-Project 01
+-I.2) Objects not present in SolMan
+-{5 Organizational Units
+- ) Master Data
=I-|J) Business Scenarios

|Ana|ysis Input

Solan Updating

+-I2) Documentation

=T Import - Compliance Management B
+-I2) Documentation
=12 Mapping

+-{3 Import Compliance Yalidation @

2] SolMan Diagram

2] SolMan Scenario Diagram

15y Organizational Units

=3 Master Data

Ih Business Processes

|2 Documentation

I e o

I Sanctioned Party List Screening
I Embargo Check
+-I2) Documentation
=12 Mapping
+-{7) Embargo Validation
+- @ Define Embargo Situation

1 -

I Product Classification {Compliance)

This tree presents the updating for a SolMan Project

E| |2 BPM-%change Solutionmanager Demo-Project 01
E|u3 Business Scenarios
E| o Import - Compliance Management
E|h3 Business Processes
m Import Control
@ product Classification {Compliance)

@ sanctioned Party List Screening
E- @ Embargo Check

2 Define Embargo Situation

B3 Embargo Yalidation

@ Integrate Embargo Checks in Existing Logistics Processes

? Release Document Blocked by Embargo Checks

+- @ Integrate Embargo Checks in Existing
+- @ Release Document Blocked by Embar
I Import Contral

+-I2) Documentation

+-I2) Mapping

+- @ Define Determination Strategy

+- @ Integrate License Determination and

=& Import Compliance Validation

Mew Object, This object has been created and linked.
Mew Object, This object has been linked,
Deleted Object or Unlinked Object.
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+- @ Simulate Import Control

+- @ Release Document Blocked by Imporl

+- @ Monitar Import Control

+ -ﬁﬂ BPM-¥change Solutionmanager Demo-Project 01,doc;

il 1 1 O v A 1

Example of a SolMan Update Mapping Report without updates

Modified Object. Characteristics of the object has been modified.
Modified Object. Components of the object has been modified.
Modified Object. Characteristics and components of the object has been modified.
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The SolMan project information is displayed in a tree.

=-{=) BPM-¥change Solutionmanager Demo-Project 01
|20 Objects not present in SolMan

5y Organizational Units

|2y Master Data

|- Business Scenarios

+-I2) Documentation

=T Import - Compliance Management B
{2 Documentation

) Mapping

£y

£y
£y

£y

1 -

£y

&0 Import Compliance Yalidation E

2] SolMan Diagram

2] SolMan Scenario Diagram
5y Organizational Units

|2y Master Data

|23 Business Processes

£y

£y
£y

{2 Documentation
I3 Product Classification {Compliance)
I Sanctioned Party List Screening
I Embargo Check
+-I2) Documentation
=12 Mapping
+-{_) Embargo Validation
+- @ Define Embargo Situation
+- @ Integrate Embargo Checks in Existing
+- @ Release Document Blocked by Embar
= Import Contral
+-I2) Documentation
=12 Mapping
+-{_) Draft Shipment Approval
+- @ Define Determination Strategy
+- @ Integrate License Determination and
+- @ Simulate Import Control
+- @ Release Document Blocked by Imporl
+- & Monitor Import Control

5 .Eﬂ BPM-¥change Solutionmanager Demo-Project 01,doc;
+-|=r) TMIDEVELDOS

Report Generation

|Ana|ysis Input

SolMan Updating

This tree presents the updating for a SolMan Project

E| a = BEPM-¥change Solutionmanager Demo-Project 01
E| = : Business Scenarios
E| a » Import - Compliance Management
Ba@ Business Processes
g-'a m Irnport Contral

#- @ Define Determination Strategy

Integrate License Determination and Checks in Existing Logistics Processes
Simulate Import Control

Release Document Blocked by Import Control

#- @ Manitar Import Control
a@ Draft Shipment Approval
-- @ product Classification {Compliance)
#- @ sanctioned Party List Screening
E| @ Embargo Check
-- 2 Define Embargo Situation
@ Integrate Embargo Checks in Existing Logistics Processes
? Release Document Blocked by Embargo Checks
D Embargo Validation
-- L+ Import Compliance Validation

‘3 Mew Object. This object has been created and linked.
i1 Mew Object. This object has been linked.

Example of a SolMan Update Mapping Report with updates

As can be seen in the SolMan Updating Mapping report example above, changes and
updates are not displayed in an "Updating" folder. They are simply added to the

tree.

This report simply indicates the mapping updates/changes that have been made but

offers no details.

Solman Project Mapped Element Report

This report displays a list of business objects mapped totally or partially with a set
of objects originating from a SolMan project.

w  You can use this report when intializing a SolMan structure from a
BPMN diagram. For more information, see "Initializing a SolMan Project
from Business Objects"”, page 39.
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Sales - SAP Analysis of a SolMan Mapped Element

@eohhl
[Add a comment]
1. Report Parameters YO] »
[Add a comment for this chapter]
2. Mapped Business Objects &R

[Add a comment for this chapter]

DI MetaClass~  |Real SAP~ Mapped~ |Active” |Global™
& provide Cruises Business Process - [ B

& sales Business Process| [~ B = G

(& provide Vacations with Boat Rental| Business Process| [~ 7 B

Accessing the report

You can launch this report from a SolMan mapped element.

w  For more information about how to generate the report, see
"Report Generation", page 62.

Displayed attributes

For each object, the following properties are displayed:

72

Object Name
MetaClass
REAL SAP: specifies whether the mapped SolMan element is a real SAP
object.
w  This attribute can be edited.
Mapped: indicates whether a SolMan element is mapped to this object.
The cell can be entered with:
e a check mark: the object is mapped with one SolMan element
e no check mark: the object is NOT mapped with a SolMan element.
e "X": the object is mapped with several SolMan elements.
Active: indicates if the mapped SolMan element is active in SAP Solution
Manager. It refers to the "In scope" concept.

w  This column is relevant only when the object is mapped with one
SolMan element only.

Global: corresponds to the Global attribute which indicates if in SAP
Solution Manager this attribute is:
e |ocal to the project
e global (defined and inherited from a more general project such as a
template project).
w This attribute is read-only.
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Report Generation

Solman Project Properties Report

This report displays the list of objects of a Solman project or part of a project.

TMIDEMOO001 KCA until May 7th 2010 -
SAP Analysis of a SolMan Project

Accessing the report

You can launch it from a:

SolMan Project
SolMan Solution
SolMan Scenario
SolMan Process

Transaction

Properties
[Add a comment]
1. Report Parameters 9 _,l
[Add a comment for this chapter]
2. Properties of a SolMan Project ®
[Add a comment for this chapter]
Name™ MetaClass™ Active |Mapped |Global~|Component™
2 perform evaluated SolMan ~ [} SAP ECC
receipt settlements ProcessStep
& collective Proc. Internal |SoMan v = SAP ECC
Orders Transaction
@ purchase Orders for SolMan = = SAP ECC
Supplying Plant Transaction
& pisplay M po  |SolMan v ™ SAP ECC
splay Hessage_ Transaction
& Rel RF SolMan ~ [~ SAP ECC
slease RFQ Transaction
= Organizational Units SolMan OrgUnit | [
Structure
@ pi SolMan SAP ECC
Display Purchase . = =
Requisition Transaction
& sAP Business Workplace |S0Man = = SAP ECC
Transaction
© Create vendor SelMan |~ = SAP ECC
(centrally) Transaction
2 Find new source of SolMan ~ [} SAP ECC
supply ProcessStep
5] Display Purchase Order SolMan =2 = SAP ECC

w  For more information on how to generate the report, see "Report

Generation”,

page 62.
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Result

For each object, the following properties are displayed:

the Name of the object with the corresponding icon
the name of the MetaClass
Active: indicates if the object is active or not in SAP Solution
Manager. It refers to the "In scope" concept in SAP.

w  This attribute can be edited.
Mapped: indicates if a mapping exists for this object of the Solman
project hierarchy.

w This attribute is read-only.

w  For more information about mapping, see "Mapping SolMan Objects
with Business Objects", page 35.

Global: corresponds to the Global attribute which indicates if in SAP
Solution Manager this attribute is:
e J|ocal to the project
e global (defined and inherited from a more general project such as a
template project).
w This attribute is read-only.
Component: displays the name of a Solman component linked to:
e a Solman Transaction
e a Solman Process Step
e a Solman Master Data
e a Solman OrgUnit

Object Differences Report

This report gives a detailed view of the differences that exist between:

the current object (the current object from which the report is displayed)
its originating object (the varied object).

It allows you to determine which elements have been added and/or deleted.

The report can indicate the differences between a
ProcessStep (the current object) in an implementation
project and its equivalent (the varied object) in a template
project.

w This report serves as a basis for generation of the following global
report: "Hierarchy Differences Report", page 75.
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Report Generation

Accessing the report

To access this report on object differences:
) In an object properties dialog box, click the SolMan Differences tab.

¥ Properties of Credit Risk Management =] E3
General | Characteristics | SAP Tranzactions | Contents | Business mapping | SolMan Documentation |
Soltdan Differences | Texts |
N
(G ] -}

1. Differences On Object

- Credit Risk Management is a variant of Presales Project template with template::Business
Scenarios::Credit Risk Management

Type”™ |Name™ MetaClass™

- Deleted | &) generic Market Data- Edit Scenario  |50IMan Transaction
+ Created|{Z) Account Pooling SolMan Transaction
+ Created| &) extraction with Delta WL + SDLTs |S0IMan Transaction
+ Created| ) cppp- Extraction of Exposures SolMan Transaction
+ Created|{Z) cppp- Extraction of Guarantor SolMan Transaction
+ Created| &) gagel 11 D/R- Test for BI Extractor |>0/Man Transaction
- Deleted | &) cppp- Extraction of PD Grids SolMan Transaction
- Deleted | &) pdministration of Scenario Runs SolMan Transaction

- Deleted | ) cppp- Extraction of Guarantor SolMan Transaction LI

QK I Lancel Apply Help |

Result

The report comprises two parts:
e the varied object in relation to the current object.
m The current object is the one from which the report is displayed.

e a table recapitulating the objects which have been:
e added

m The added objects are the objects owned by the current object and
which do not exist in the varied object.

e deleted

m  The deleted objects are the objects owned by the varied object and
which do not exist in the current object.

Hierarchy Differences Report

This report lists all the differences existing within a project or hierarchy. The
differences are listed object by object.

w [t aggregates the results of the following report: "Object
Differences Report", page 74.
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Accessing the report

you can launch this report from a:

Result

SolMan project
SolMan scenario
SolMan process

w  For more information on how to generate reports, see "Report
Generation", page 62.

If you launch the report from a SolMan scenario, the following data is collected:

First, data concerning this scenario.
Second, data concerning all Solman processes, SolMan process steps

and SolMan transactions.

The report is divided into several chapters:

SolMan Project differences
SolMan Solution differences
SolMan Scenario differences
SolMan MasterData differences
Solman OrgUnit differences
SolMan Process differences
SolMan ProcessStep differences
SolMan Transaction differences
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HOPEX SAP BLUEPRINT GLOSSARY

The glossary presents the main concepts used in HOPEX SAP Blueprint.

business process

business process step

business scenario

implementation
project

maintenance project

master data

organizational unit

process step

More often referred to as Processes in SAP Solution manager, these
objects are used to group Business steps.

More often referred to as Process Step. In SAP Solution Manager,
this object is used to represent business activities.

More often referred to as Scenarios in SAP Solution Manager,
scenarios are used to group sets of business processes. They may
be used to represent types of models such as value chains,
functions and business domain object types.

An implementation project is used to implement business
processes in an SAP landscape.

A maintenance project is used to maintain changes in the
productive environment (solution).

Master data refers to data objects which contain control data that
are relatively constant over time. This data does not change very
often. Master Data may be assigned at the project-level as well as
at the scenario level. At the project level, they are used within the
scope of the entire project. At the scenario level, they are
responsible for the corresponding business scenario and all its
related business processes.

In SAP Solution Manager, an Organizational Unit can refer to a
business object used to define the financial and logistic structures
within a specific SAP component.

A process step is an elementary activity performed to accomplish
a process.
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system landscape

template project

transaction

A system landscape is composed of an arbitrary number of
components which are referenced by process steps and
transactions.

A template project is used to create and distribute a template
defining the project structure.

In SAP Solution Manger, a transaction is actually a dialog or a form
and can therefore be compared to a business transaction. For
Master Data and Organizational Units, transactions are used to
maintain the corresponding master data or organizational unit.

HOPEX SAP Blueprint
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INSTALLING THE MEGA / SOLMAN INTERFACE

Although the MEGA / SolMan interface is installed with HOPEX SAP Blueprint it requires installing
additional components.

Making MEGA/Solution Manager interface fully operational requires:
e Unzipping installation files
e Installing the transport order
¢ Installing the SAP Java Connector
e Installing additional shapes
e Copying the HOPEX SAP Blueprint generation parameter file (if you need to generate SolMan
objects from business objects as well as the associated report).
Unzipping installation files
The MEGA / SolMan CD contains the following files:
* mega_solman interface installation.doc: This document.
e transport_order_xxx.zip: Transport Order files to import to the SAP System.
e patch_xxx.zip: An update to the Transport Order if necessary.

¢ solman-shape.zip: Contains additional shapes for BPMN elements mapped to HOPEX SAP
Blueprint objects.

Installing the transport order

The transport order (and its update if necessary) must be installed on the SAP server.

Installing the SAP Java Connector
To install the SAP Java connector component (SAP JCo):

1. Download it from SAP web site with your SAP customer identifier.

MEGA / SolMan Interface - Installation page 2/3 mega




2. Copy sapjco3.dll and sapjco3.jar files to the “java/lib directory” of MEGA installation path.

Installing additional shapes

Additional shapes are available for BPMN diagrams to identify objects mapped to a MEGA SolMan element.

To install these shapes:

1. Copy all .mgs files from “solman-shape.zip” to the “Mega_Usr” folder.

2. Import the .mgl file to the system database of your environment.

Copying the generation parameter file

The wizard for generating SolMan objects from business objects and the associated report “SolMan Project
Mapped Element report” require creation of a parameter file.

For more information on the contents of the parameter file, see the HOPEX SAP Blueprint user guide, chapter “Designing for
SAP Projects”, paragraph “Initializing a SolMan project from business objects”.

This mapping file must be copied to the following folder:

<Environment folder>\Db\<Repository Name>\USER\<User Name>\megasolmanbusinessimport.ini
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Summary

This document describes the system requirements and deployment types for MEGA Solman.
HOPEX SAP Blueprint has an interface with SAP Solution Manager.

This document applies to
« HOPEX V1R2 CP8.0 and higher CPs.
« HOPEX V1R3 CP8.0 and higher CPs.

It does not describe:
« How to perform installations (see installation documentation).
« How to upgrade installations (see CP/SP upgrade documentation).
« How to manage installations (see administrator manuals).
« How products are licensed (see licensing documentation).
« How to use features (see user manuals).

HOPEX SAP Blueprint Architecture Overview age 2/7
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DEPLOYMENT

Here is a short description of the most common deployment model, recommended for standard
requirements.

2 main nodes are involved:
e Windows Client (HOPEX Windows Front-End).
« SAP Server (SAP Solution Manager Server).

MIK

Call (Java) Response (Java)

Windows Client
JCo

i

|
RFC Request RFC|‘ Response

SAP Solution
Manager >

SAP Reference Model

SAP Server

Note that other components (SQL Server Native client, Flash player) can be required on the
Windows client depending on the situation. See the article 'Windows Front-end Architecture
Overview HOPEX V1R2-V1R3 EN'.
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DEPLOYMENT REQUIREMENTS

Windows client

Client System (1) Windows 7.0 SP1 (32-bit or 64-bit)
Windows 8 (32-bit or 64-bit)
Windows 8.1 (32-bit or 64-bit)
Windows Server 2008 R2 SP1
Windows Server 2012 SP2
Windows Server 2012 R2

MEGA Version HOPEX V1R2-V1R3 (2)
Hardware Processor

multi-core

RAM

2 GB minimum

4.0 GB or higher recommended
Resolution and colours

16 M colors

Screen resolution

800 x 600 minimum

1024 x 768 or better recommended
Disk space

4 GB for MEGA Kernel

JCo 3.x (version 3.0.9 and higher)

(1) System supported by HOPEX V1R2-V1R3 Windows Front-End.
(2) HOPEX V1R2-V1R3 installs and runs a private JRE version 7 (32-bit).

Verify that the version of JCo is compatible with:

« The client system used.
» The JRE used.

SAP Server

SAP Version SAP Solution Manager version 7.1
Transport order build 900879 and higher (3)

(3) The version of transport order may vary with the CP number. The appropriate version of
transport order is installed in the subfolder "\Utilities\Solman' of the HOPEX installation. See
also compatibility table later in this document.
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COMMUNICATION

Between Windows Client and SAP Server

Protocol

RFC protocol

Port

Refer to you SAP Administrator (*)

(*) See also this web page

http://www.sdn.sap.com/irj/scn/go/portal/prtroot/docs/library/uuid/4e515a43-0e01-0010-

2dal-9bcc452c280b?QuickLink=index&overridelayout=true

HOPEX SAP Blueprint Architecture Overview
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GLOSSARY

Term
Environment, MEGA environment

' Definition

A MEGA Environment is a working area, storing data of a
user group. Within a MEGA environment, a set of data
repositories share within a system database a metamodel
definition, users and profiles. An environment is thus made
of a single system database and of one or multiple data
repositories.

HOPEX SAP Blueprint

HOPEX SAP Blueprint is a specific product supported by
MEGA and is sold separately from SAP Solution Manager. It
enables the import/export of data into/from SAP Solution
Manager and the mapping of imported data with MEGA
Process BPMN data.

JCo

SAP JCo (Java Connector) is a SAP component that enables
to build interfaces between SAP software and other tools
The product HOPEX SAP Blueprint uses an interface with
SAP Solution Manager.
The technology of the interface varies with the version of
MEGA:

« MEGA 2009 SP5 CP9.0 and Ilower: BPM-X

technology is used
+ HOPEX: JCo technology is used

MEGA License, license

Licence used to run MEGA Software (Product, Module or
Bundle). There are different technologies available. The
most common one is the MEGA Must licence.

SAP Solution Manager

Solution Manager is a SAP tool provided with the
Netweaver platform to design, implement, manage and
monitor SAP system implementation.

SAP User Account for HOPEX SAP
Blueprint

SAP User account used to exchange data between HOPEX
SAP Blueprint and SAP Solution Manager.

Transport Order Package

Installation package provided by MEGA. It uses the
Transport Program of the SAP system.

HOPEX SAP Blueprint Architecture Overview
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FAQs

Can HOPEX SAP Blueprint run with Citrix?

Yes. The Windows client can be a Citrix Server.

Do I need to install C++ runtimes to run on Windows for JCo?

No. These runtime components are already installed with MEGA Windows Front-end.

How can I get JCo?

MEGA does not distribute this component. Use a valid account on SAP Service Market Place to
download it. See your SAP administrator.

What are the system requirements for SAP JCo?

MEGA does not distribute this component. Use a valid account on SAP Service Market Place to
download it. See your SAP administrator

How can I install JCo?

Refer to ‘"MEGA SolMan Interface Installation Guide HOPEX V1R2-V1R3’ in HOPEX SAP Blueprint
user guide.

How can I get the Transport order?

The appropriate transport order is installed in the subfolder "\Utilities\Solman' of the

installation.
Ex: C:\Program Files (x86)\MEGA\MEGA HOPEX V1R2\Utilities\Solman

Compatibility table

Depending on the version of MEGA, certain versions of the client and server layers are
required. It may not be possible to use different versions of MEGA with the same SAP Server.
of the

in the subfolder "\Utilities\Solman'

installed

The appropriate transport order is
installation.

Version of MEGA

Interface client

Interface server | SAP Compatibility
layer

layer

HOPEX V1R2 3.x (version 3.0.9 | Transport order build | Compatible with SAP
HOPEX V1R2 CP1.0 and higher) 900478 Solution Manager 7.1
HOPEX V1R2 CP2.0 3.x (version 3.0.9 | Transport order build | Compatible with SAP
and higher) 900605 Solution Manager 7.1
HOPEX V1R2 CP4.0 3.x (version 3.0.9 | Transport order build | Compatible with SAP
and higher) 900879 Solution Manager 7.1
HOPEX V1R2 CP8.0 3.x (version 3.0.9 | Transport order build | Compatible with SAP
HOPEX V1R3 CP8.0 and higher) 900879 Solution Manager 7.1
HOPEX SAP Blueprint Architecture Overview
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